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Stream 2.5 Software 
 

Stream 2.5 Installation and License  
 

System Requirements 

Stream 2.5 requires Windows XP SP2 (or higher) or Windows Server 2003 operating systems. 

Windows Vista Business and Ultimate Editions are also supported, however, please see the Known 
Limitations section at the end of this document for known Vista Issues.  

Windows 2000 is no longer supported. 

Stream 2.5 requires a P4 CPU or better.  Faster processors and/or multi-core processors are 
recommended for processor intensive codecs. 
 
Registration 

 
YOU MUST REGISTER YOUR PRODUCT TO UNLOCK ALL FEATURES.   
 
Go to http://www2.digital-rapids.com/Support_Registration2.php to register your product. 
If you have already installed the Stream software you may use Tools > Register Online to go to the 
registration page with your product ID automatically filled in for you. 
 
License 

If you have a license for Stream 2.0 - 2.4 you will not require a new license to upgrade to 2.5. It is a free 
upgrade for Stream 2 customers.  However, Stream 2.5 does introduce some new optional, paid features. 

Stream LE (basic):  You can run Stream LE 2.5 with a 1.5 license or a 2.0 - 2.4 license. If you already 
have a 1.5 license you do not need to get a new license. 

If you have a StreamPro 1.5 or StreamEnterprise 1.5 license please contact your dealer for information 
about upgrading to Stream 2 LE with Deck Control (which is free, but requires a new license), or 
StreamPro 2 or StreamEnterprise 2. 
 

Installation Options 

 
The Stream Installer includes optional components that you will see if you select a “Custom” install and 
expand the install tree. 

 

http://www2.digital-rapids.com/Support_Registration2.php
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INSTALLATION NOTE for Windows Media 
When you install Stream, the installer will detect which version (if any) of the Windows Media codec you 
have installed.  If it is older than the codec installed with Windows Media Player 11, then you will see a 
window that recommends that you upgrade, and the installer will copy the required wmfdist_v11.exe file 
to your system.  (On Windows XP systems this file will typically be copied to C:\Program Files\Common 
Files\Digital Rapids\WMF Installer\wmfdist_v11.exe.) After Stream has been installed, run this file to 
install the latest Windows Media codec. 
 
INSTALLATION NOTE for QuickTime:  If you intend to encode to or transcode from QuickTime files, 
then Stream 2.5 requires the QuickTime 7 player to be installed. If you install QuickTime 7.4 (or newer) 
the default codec list will be shorter then with previous versions of the player. To show the complete list, 
open the QuickTime player, select Edit > Preferences > QuickTime Preferences, then select the 
Advanced tab, and check the "Enable encoding using legacy codecs" box. 

Note that the QuickTime H.264, AAC audio and AMR audio codecs are enabled in Stream 2.5 for 
StreamPro and Stream Enterprise, but not for Stream LE. 
 

Note For those upgrading from Stream 1.5  

Codec Profiles and Projects saved in Stream 2 cannot be used in Stream 1.5.   
 
 

Tips for using StreamZHD software (DRC-5550/5650)  
 
For HD capture be sure to direct your Output Media to the video RAID (the 4 drives striped together).  If 
you attempt to capture uncompressed HD video to your system drive it will not be able to keep up and 
you will see dropped frames after the buffer fills to 100%. 
 
For HD capture you will be able to capture any resolution or frame rate to an uncompressed AVI or DRC 
Video file in real time.  For capture to a Windows Media or MPEG2 clip, the real time capabilities will be 
dependant on the host system.  For example, a dual single-core 3.6 GHz Xeon CPU system will be able 
to capture 1280x720 at 24 fps for both Windows Media and MPEG2.  A dual dual-core Intel 5160 CPU 
system will be able to capture MPEG2 up to 1920x1080 at 30 fps in real time (but not Windows Media at 
the same frame size). 
 
For standard definition NTSC video, the HD board can be set to capture to 720 x 486 or 720 x 480.   
If you need to capture 720 x 480 (for example for a DVD), be sure to select this in the source profile so 
that later the video is not scaled from 486 to 480. (Note that 720 x 512 is also an NTSC option, for cases 
where you need to capture all of the VBI lines.) 
 
Creating an input Source Profile (for live capture or deck capture) is different for the HD board than it is 
with the SD boards. For example, for HD boards deinterlacing is set in the Source Profile (it is not a 
setting on the Video Process tab as it is for the SD boards). Please check the User’s Guide. 
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Stream 2.5 Highlights 
 
 
Included with LE/Pro/Enterprise:  
 
New video software plugin: deinterlacing 
 
The ability to insert copy protection data into MPEG2 files (CGMS-A and VChip)  (For those who have the 
MainConcept MPEG codec) 
 
 
Included with Pro/Enterprise: 
 
Thompson mp3 audio codec – included for new Stream 2.5 Pro/Enterprise customers. (This codec is 
available as an option for LE or for Stream 2.4 customers who are upgrading to 2.5.) 
 
New video software plugins:  gamma adjustment, 601/709 color space conversion 
 
Omneon MOV format writing (MPEG2 inside a QuickTime wrapper) 
 
QuickTime v.7 includes support for H.264/AMR/AAC (these codecs are not supported in LE) 
 
Support in Stream for the Rimage Server (as a DVD output option) – available for all Rimage/StreamPro 
customers, but a free key must be requested from Digital Rapids to expose the feature 
 
2.5.1: Support in Stream for the Primera Server (as a DVD output option) – available for all 
Primera/StreamPro customers . A free key must be requested from Digital Rapids to expose the feature 
 
2.5.1: Microsoft VC-1 elementary stream codec added – can be used to create Bluray files or can be 
used in the group codec to create muxed ASF files and streams. 
 
New Options 
 
2.5.1: Digital Rapids Studio AVC codec – can be used to create Bluray files or can be used in the group 
codec along with additional options to create Transport Stream files for VOD or RTSP/RTMP live streams 
for delivery to a Media Server (e.g., Flash Media Server or Darwin Server).  
 
2.5.1:  Digital Rapids AVC for Flash 9: This codec includes The Digital Rapids AVC video codec, the Nero 
AAC audio codec, and the RTSP/RTMP protocol for live streams for delivery to a Flash Media Server. 
 
Codec for 3GPP support:  Dicas (video: H.263/MPEG 4 Part 2; audio: AMR and AAC) 
 
Optional Input File format: GFX reading 
 
Optional output format for Pro/Enterprise: MXF file writing 
 
2.5.2:  MPEG-4 Muxer processor for creating archive files now included when Digital Rapids Studio AVC 
or Ateme codecs have been enabled. 
 
2.5.2:  Digital Rapids AVC for Flash 9: Added File Writing using the new MPEG-4 Muxer; Added video 
only and audio only options; Added MP3 audio streaming option. 
 
2.5.2:  New tool to wrap encoded files in MXF; included if the MXF Writer processor has been enabled. 
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Stream 2.5 Change History 
 

Stream 2.5.1.b47 to 2.5.2.b63 
 
Added a new MPEG-4 Muxer processor for creating archive files.  
Available as a processor in the group codec when Digital Rapids Studio AVC or Ateme codecs have been 
enabled. Also available from the Digital Rapids AVC for Flash 9 codec. 
 
Added a new tool to wrap encoded files in MXF; included if the MXF Writer processor has been enabled. 
 
Added MP3 audio streaming using Native RTP processor (in the group codec) or from the Digital Rapids 
AVC for Flash 9 codec. 
 
Allow audio-only or video-only clip lists. After setting Clip List as your Input Type, choose “none” in the 
video or audio drop down if your clip list does not include that type of media. 
 
Closed Captioning for MPEG2: Reversed the packet order of the Dual CC placement in MPEG2, so that 
the SCTE 20 user data packet is put before the ATSC A/53 user data packet.  This is required for VOD 
files made for a CableLabs server. 
 
Improved the exit process from Stream which kills all associated processes when you exit Stream. 
(Previously if the encoder locked up, some processes were not killed when you exited Stream.) 
 
Field Dominance Converter Plugin: Do not swap field 1 and 2 timecode and VBI data. 
 
Don't show Vista warnings when the OS is Windows Server 2003. 
 
Fixed a bug in the Group Codec: Plugins that were applied to a codec that were part of a Group Codec 
were deleted when an individual codec was modified. Note that this bug has not been fixed when using 
the DR AVC for Flash 9 codec (a special use case of the group codec structure). 
 
RTMP Streaming: 
Update to Adobe RTMP SDK 1.0.1 which includes bug fixes to increase the stability of the live stream. 
Update support for RTMPT streaming, especially for reconnection issues. 
 
Native RTP Streaming: 
Fixed some SDP issues when using video only or audio only and sending to Darwin server. 
Fixed some SDP issue related to local sdp file when streaming to Darwin server or Built-in server. 
Some fixes to better support streaming to Akamai server through RTP. 
 
Adobe Flash 8 On2 Codec: 
Update to On2 SDK 2.4.5.0 
- metadata preservation in files, and some metadata preservation in live streams 
- Can once again make SWF files 
Includes a fix for transcoding to On2 from files that have some frames that have the same timestamp as 
the previous frame. 
Added feature to enable On2 VP6-S encoding type via a registry key setting (without this key the 
encoding type is VP6-E).  This will also add an entry to the Metadata to inform the user if the profile 
selected is "VP6-E" or "VP6-S". 
The registry key to enable is: 

Windows Registry Editor Version 5.00 
[HKEY_CURRENT_USER\Software\DRC\On2] 
"UseVP6SProfile"=dword:00000001 
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QuickTime: 
Fixed a bug that caused QT capture to 23.978 fps to have a lipsync problem 
Fixed a bug that caused GUI crashes when entering QT dialog using AVID codec pack 1.8 or 1.9  
Fixed a problem when transcoding from QuickTime file source that occasionally causes the application to 
lock up at the end of the encoding. 
For QuickTime encoding, if the output frame rate is greater than the input frame rate the encode will fail 
with an error message that tells the user that going to a higher output frame rate is not supported. 
 
Omneon MOV files: 
Use a new a decoding method for decoding Omneon MOV files in Stream 
Always include timecode in output Omneon MOV. It will default to Zero TC if none is present. 
Allow user to delete Audio files from the Omneon dialog, even if these files were added automatically. 
Fix bug that caused, Aiff multichannel audio to show up as mono. 
Dicas: 
Bug fixes to allow Dicas encodes to Stream to Akamai server. 
Use the correct profile Level/Id when using MPEG4 encoder and bit rate is less than 64kb/s. 
AAC audio was incorrectly encoded at 96kbps when bitrate was lower than 16kbps. It will now correctly 
support down to 8kbps. 
 
File trimming behavior can be changed based on a registry setting. The two behaviors are “true seek” and 
“play to in point”. The “true seek” behavior is the default behavior if the reg setting is not present. This 
was introduced as the “true seek” method will not work if the file has seeking issues. 
 Windows Registry Editor Version 5.00 
 [HKEY_CURRENT_USER\Software\DRC\KMDSFileSource] 
 "EnableTrueSeeking"=dword:00000001 

(Disable: set the dword to 00000000) 
 
Chinese translations of most of the Stream gui will be enabled if a Chinese OS is detected.  
 

Stream 2.5.0.32 to 2.5.1.b47 
 
Warning 
 
This build includes an updated On2 SDK that does not support SWF file creation. If you require SWF file 
creation you will need to apply a patch to the Stream 2.5.1 build or to update to Stream 2.5.2. 
 
Codec changes 
 
Microsoft VC-1 elementary stream codec added – can be used to create Bluray files or can be used in the 
group codec to create muxed ASF files and streams. This codec requires StreamPro or Enterprise. 
 
Digital Rapids Studio AVC codec – Can be used to create Bluray files or can be used in the group codec 
along with additional options to create Transport Stream files for VOD or RTSP/RTMP live streams for 
delivery to a Media Server (e.g., Flash Media Server or Darwin Server). This codec requires StreamPro or 
Enterprise. 
 
Digital Rapids AVC for Flash 9: This codec provides an integrated interface for Flash 9 live streaming. It  
includes the Digital Rapids AVC video codec, the Nero AAC audio codec, and the RTSP/RTMP protocol 
for live streams for delivery to a Flash Media Server. 
 
QuickTime: 
- Fixed a few memory leaks, including the one that caused a large memory leak when Uncompressed 
video, Preserve TC and PCM Audio are selected.  
- Fixed a bug so that QuickTime audio only encoding works 
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- Fixed a bug that caused QuickTime to encode at a frame rate that is little bit off from the selected one 
(due to a rounding error).   
- Fixed a bug that caused QuickTime audio and video durations to be different. 
 
MainConcept MPEG2: 
- MainConcept decoder deinterlacing is now directly controlled by Stream encoder.exe. Previously the 
decoder was deinterlacing the video by default. 
- Updated MainConcept MPEG2 SDK. 
- Added Cable Labs constant for MainConcept profile. 
 
On2 Codec (Flash 8):  This build includes an upgrade to On2 SDK version 2.4.2.0.  This updated SDK 
includes the following: 
- metadata preservation in files (but not in live streams) 
- mono audio is fixed in older players 
- However, you can’t use this version of the SDK to make SWF files (see warning above) 
Additional On2 codec changes: 
- Fix for auto-aspect ratio adjustments and the On2 codec. This fixes a bug where any time the video 
dimensions needed to be changed by Stream for an On2 codec profile it would result in an unusable 
codec profile. 
- Fix for a bug involving Limelight publishing after a reconnection.  Before the fix Limelight broadcast 
streams were not published correctly due to an improper publish call.  With the fix a more robust 
mechanism have been put into place to publish the stream properly upon a reconnection. 
 
General Changes and Bug Fixes 
 
Added support for Primera DVD Burner Server. Requires a registry setting to enable. 
 
Fix DTD URL in Rimage order XML.  Fixed DVD UDF Format - now 102ISO instead of 150_Unicode (to 
fix UDF Format issue with Rimage DVD Burner Server). 
 
Integrated the StreamScheduler into the main installer as an optional feature. Previously this feature had 
its own installer, but that was causing version incompatibility problems. 
 
Deck Control:  
- Allow the user to disable the warning about overwriting files if system tags are not used 
- Fixed a deck logger problem. When a new tape is inserted, a dialog shows up to allow the user to select 
the tape. If a new tape name is added, the new tape name was not automatically selected. 
- Deck Capture warning: Fixed a bug where warning for SCC + Deck Capture validation wasn't being 
triggered when SCC was completely out of range of the deck clip in/out points from the top end.   
 
Corrected the error message that is displayed when the license limit is exceeded. 
 
Fixed group encoder to report the maximum frame size in the status bar. 
 
Added %APP.HARDWARE.NAME% tag. 
 
Fixed a memory leak in the software cropping plugin. 
 
MXF File Writing/Reading: 
- MXF Reading now can handle 16 track audio (previously it could only handle up to 8 tracks) 
- Fixed a bug that could cause problems when reading MXF files with multiple audio streams.   
- MXF writing: changed default stream buffer sizes to 16384; exposed SDK stream buffer sizes in UI 
- added ability to wrap WAV streams as AES3 in OP1A and OPAtom output patterns. 
- Fix: Invalid MXF file hangs Stream during preview/encode. Solution: Stop method now explicitly stops all 
media sources, so that the Stream will respond when the Stop button is pressed. 
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GXF Import bug fix: GXF file with DV video is now decoding properly  
 
Improvements to the DRC-5650 DirectShow Preview Player App and SDK. 
 
DRC-5650 and 5550 drivers: 
- Fixed a cropping lock-up that would occasionally happen when no SDI input was present. 
 
 

Stream 2.4.1.67 to 2.5.0.32 
 
Codec changes 
 
Added Dicas codec support. This new optional codec support H.264/AVC, MPEG4 Part 2, H.263, AAC 
audio, AMR audio. It supports both file creation and live streaming (native RTP broadcast). 
 
Added GXF Import support: This new option allows you to use GXF files as a Media File type (read GXF 
files so that you can transcode them to other formats). Note: GXF unwrapping is supported.  Additional 
codecs may be required to read the elementary video and audio streams inside the GXF wrapper. 
 
Added MXF file writing support (wrapping): This new option allows you to choose the MXF wrapper as a 
new Processor in the Group Codec. Note: MXF wrapping is supported, but additional codecs may be 
required to write the elementary video and audio streams inside the MXF wrapper.  
 
Added the Thompson mp3 audio codec – This codec is included for new Stream 2.5 Pro/Enterprise 
customers. This codec is available as an option for LE or for Stream 2.4 customers who are upgrading to 
Stream 2.5. 
 
Omneon MOV format file writing is included for StreamPro/Enterprise customers (MPEG2 plus audio 
inside a QuickTime wrapper). This feature is available as both a post encode output option that 
automatically wraps the MPEG2 and audio files that have just been encoded, as well as a tool that can be 
used to wrap previously encoded MPEG2 and audio files. 
 
Updated the MainConcept MPEG codec to version 7.5.  This new version includes improvements to the 
D10 quality, quad-byte alignment for CableLabs compliance, an improved decoder, as well as various 
other fixes.  Additional MainConcept changes: 
- The decoder now decodes video without deinterlacing it by default 
- When “no fields” is selected the progressive sequence flag is set to 1 automatically 
- The default quality has been increased to 30 (maximum is 50) as most CPUs can now provide the 
processing power needed to handle this higher default quality 
- Added a new option for XDS data insertion, which includes options for CGMS-A data and Content 
Advisory (V-Chip) Information 
- Added new closed captioning options so that users can choose which type of captions to add to the file:  
ATSC A/63, ATSC A/53, SCTE20, Dual ATSC A/53 + SCTE20 
 
Adobe Flash 8 On2 updates: 
Updated to the On2 VP6 SDK to version 2.2.15.0.  This version of the SDK fixes the transcoding bug 
where frames were cut off at the end of a transcoded file.  It also fixes the long-term live streaming issue 
where the audio and video timing would gradually drift apart until the encoder failed (at approximately 14 
hours).  Additional changes: 
- Added an On2 reconnection feature for live streaming. This feature will detect if a broadcast stream has 
disconnected and attempt to reconnect the stream at 15 second intervals. A disconnected stream will 
attempt to reconnect for 5 attempts.  If a stream is unable to reconnect after 5 attempts the encode 
session will fail. 
- Updated the codec to use the Thomson MP3 audio codec (The LAME audio codec was used in previous 
releases.) 
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- Updated the Akamai and Limelight login procedures to provide more graceful connection to the servers. 
- Enabled the alpha Option in On2, which allows Stream to pass RGB32 video to the encoder for 
transcoding. 
- Reorganized parts of the On2 codec profile gui to make the functionality clearer 
- Enabled SWF dimensions feature in On2 codec profile gui 
 
 
 
QuickTime codec changes: 
Updated the QuickTime  SDK to version 7.1.  When using existing QuickTime codec profiles from earlier 
builds of Stream you will see an error message warning you to update the audio profile, as the method for 
handling audio is not backwards compatible.  Other changes: 
- Multi-channel audio is supported (mono to 8 channels) 
- StreamPro and Enterprise:  the Apple H.264 video codec is supported, as well as AAC LC and AMR NB 
audio codecs. Note that for Stream LE customers these codecs are not supported. If you have a Stream 
LE license and you choose one of these codecs, when you start to encode you will be warned that you 
are not authorized to use these codecs. 
 
Digital Rapids AVC (Nero Digital) codec changes: 
- Added a new option to modify files to allow progressive download for a Nero Digital AVC/H.264 file 
(involves moving the MOOV atom in the file from the end of the file to the beginning of the file). This is an 
option in the Archive output dialog when writing an AVC/H.264 file, and it is enabled by default. 
- Added two more file extensions to the Nero Digital window list (f4v, flv) for Flash 9 file compatibility 
- You can now transcode to the Nero Digital codec from source files with 24-bit audio. The 24-bit audio 
source will now automatically get down sampled to 16-bit (as required by the Nero Digital codec). 
- Fixes for the 2-pass encoding option to allow better specification of the temporary first pass bin file. 
These changes allow it to work properly when called from Digital Rapids Transcode Manager. 
 
Closed Caption codecs: 
- SCC: Fix for a bug in the SCC encoder where the caption timecode would drift away from the actual 
timecode from the video.  The bug was caused by an imprecision in the calculation of the timecode from 
the frames when dealing with 29.97 fps frame rates. 
- In SAMI output files the reference to "&nbsp" should actually be "&nbsp;" with a semi-colon 
 
Windows Media codec: 
- Fixed a problem in Windows Media encoder when determining which deinterlacing mode to use in MBR. 
- The Windows Media Codec Distributable wmfdist11.exe included in the installer is now Version 6.1.22.4. 
This version works better with Server 2003. 
 
MXF authorization:  Fixed an MXF authorization issue that primarily affected it’s use with Digital Rapids  
Transcode Manager 
 
Image Sequence: Added start time and end time to image sequence encoder output. 
 
DRC Video File format changes: 
- The DRC Video format has been changed slightly to include ancillary data. DRC Video files encoded 
with earlier versions of the software will need to be converted before they will be able to be decoded. A 
DRC Video file converter is available for this conversion task. 
- The DRC Video Properties page (displayed when you right click on a DRC Video file and choose 
Properties) has been enhanced. 
 
Fixed a Sorenson ACE profile reading problem. 
Fixed a Sorenson ACE profile name problem. 
Fixed a Sorenson ACE SWF encoding problem. 
 
Deck Capture bugs/changes 
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Deck control behavior has changed slightly. Now when a new tape is inserted a cue command is always 
sent by default. This resolves an issue where the timecode type was not correctly detected after a tape 
change unless the tape was played for a few seconds. 
 
When “concatenate clips” is enabled, capture the clips in the order that they have been entered (that is, 
do not sort them by timecode before capturing them).  Note that when “concatenate clips” is not enabled 
Stream does sort the order in which it records clips. 
 
The Logger’s 24-hr and 12-hr timecode wrapping options are once again working as expected. For 
example, with 24-hr wrapping enabled, with an in point of 23:59:30:00 and an outpoint of 00:00:30:00 the  
duration is correctly shown as 00:01:00:00, and the capture starts as expected. 
 
Stream will ignore the video input signal from the deck during stop or shuttle modes, and will only attempt 
to detect the video input when encoding is about to start. This will help to prevent “failed to detect SDI 
video input” errors when using certain decks along with an SDI input and Deck capture to encode a list of 
clips. 
 
Fixed: Deck Capture: No preview was shown after first clip in the capture list was encoded (you had to 
toggle the preview button to see the preview for subsequent clips). 
 
Fixed: Deck capture to MPEG2 when encoding closed captions from SCC file source failed. 
 
When a project is open that has an existing deck capture log, if Stream detects that the frame rate of the 
SDI input does not match that of the capture log, a warning will be displayed that tells the user that they 
must clear the capture log to re-set the frame rate used by the capture log. 
 
General Changes and Bug Fixes 
 
New video software plugins:   
For Stream LE/Pro/Enterprise customers: software deinterlace plugin 
For Pro/Enterprise customers:  gamma adjustment, 601/709 color space conversion, Field Dominance 
Converter 
 
When the codec profile is modified, the plugin settings are no longer lost. 
 
Support in Stream for the Rimage server (as a DVD output option) – This feature is available for all 
Rimage/StreamPro customers, but a free key must be requested from Digital Rapids to expose the 
feature. Currently Rimage 8.0 is supported. 
 
Native RTP Processor in the Group Codec: Added support for unicast to a Darwin Server, including SDP 
file announcement and username/password announcement. 
 
System Tag: Added %N.#% as short form of %FILENAME.NUMBER.#% 
 
Add tooltip to Output’s Archive window listing common tags used for file names. 
 
Added a subject field to the Email Output option to allow the user to define the subject of the email. 
 
When trancoding files and also using the Graphics Overlay plugin, only media source files that used 
YUY2 or UYVY were being transcoded. When using a media source file that used RGB the graphic 
overlay plugin would fail. Now when transcoding media source files that are RGB, the graphic overlay 
plugin will work correctly. 
 
Added Silverlight sample template files to the installer (installed by default in C:\Program Files\Digital 
Rapids\Stream\PublishTemplates\Silverlight_Sample) 
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Added WAV codec as an option to the group codec; primarily used to create certain MXF file types. 
 
Added WAV RF64 support for WAV files over 2 GB in size. 
 
Add a warning message to alert the user if they have hardware de-interlace enabled and have also 
applied the IVTC filter. 
 
When an illegal character (such as an &) is used in a file name or folder name Stream now returns the 
correct error. 
 
When using a Watch Folder with concatenate enabled, the status indicator is now updated from a red dot 
to a green check (to indicate successful completion). 
 
When using a Watch Folder, files encoded with some codecs were being picked up by the watch folder 
process before the file had finished encoding. Problematic codecs were Flash, MPEG, Real, QuickTime 
and Wav.  This has now been resolved. 
 
Fixed:  When using the trimming options for Media File input, the settings entered are stored, and when 
you go to File > New Project the trimming parameters were not being cleared when starting the new 
project. 
 
When using the group codec, the correct error message will now be generated when an illegal character 
is used for the output file name. 
 
When using the group codec, if the H.264 or MPEG2 codec uses an SCC file that cannot be found, then 
an appropriate error message will be displayed (previously this could lock up the app). 
 
DRC Hardware Drivers – changes and bug fixes 
 
DRC-5560 and 5550 boards: 
- Fixed the random number generator used for random dithering. 
- Fixed bugs related to playback engine rendering interlaced video in frame mode. 
 
DRC-1000 to 2600 boards: 
- Changed the field 2 VBI minimum start line from 273 to 272 and fixed a field 2 VBI line problem 
- Changed audio timestamp calculation to use floating point.  The old way (using fixed point) would cause 
an overflow of the numerator after about 14 months. 
- Changes that help to avoid timing problems when 2 streams are capturing, starting, and stopping 
simultaneously. 
- Changes that fix the "31 dropped frames" problem that can occur without the host buffer filling up. 
   
Note: No changes for the DRC-500 board. 
 
DRC Key Change 
 
This release uses the new key authorization structure, expanded to allow more codecs/options. All keys 
made after April 13, 2008 will use this new key structure. If you are using a new key and Stream 2.4 or 
earlier, use the DRC Key Patch found on http://www.digital-rapids.com/Support/StreamSupport.aspx.  
 

Stream 2.4.0.50 to 2.4.1.67 
 
Group Codec:   
- Added Native RTP pull mode (previously just RTP push mode was available).  Also added support for 
RTSP working with RTP unicast. 

http://www.digital-rapids.com/Support/StreamSupport.aspx
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- If the Group Codec is not enabled in the key, then the Processor Profile menu will be hidden 
- Properly display group codec Audio Level sliders in Audio Level Tab, adding scroll bars to the window if 
necessary 
- When the MainConcept encoder is used as the video stream source in the group codec along with the 
Manzanita TS muxer, it now correctly sets the number of access units to accumulate prior to muxer 
initialization. Previously, some projects using the MainConcept encoder and the Manzanita TS muxer 
failed to initialize the muxer successfully. 
 
Ateme H.264 codec changes: 
- Disabled various attributes in Ateme dialog when Baseline profile is selected (as they are not available 
in the Baseline profile):  B frames, weighted prediction, CABAC, MBAFF 
- Added description to the NumSlices attribute in Ateme profile dialog. 
- streams now contain buffering period messages 
- fixed frame rate streams now have correct picture timing messages 
- progressive streams now have picture timing messages 
- Note that in this updated SDK the variable frame rate mode has been broken, and the variable frame 
rate mode has been disabled in Stream until the issue can be resolved. 
- NAL unit prefixes (in AVC elementary streams) may be 3 bytes or 4 bytes.  However, some STBs 
require 4 byte prefixes for the rewind function to work properly.  You can use a reg key to force the NAL 
unit prefixes to 4 bytes.  Please contact Digital Rapids support if this applies to you. 
 
Manzanita TS Muxer changes: 
- To prevent underflow issues, during group processing the desired (target) bitrate is passed to the muxer 
directly by encoder. Note that the video encoder bitrate will automatically be slightly reduced to ensure 
that an underflow does not occur at the desired muxed bitrate. 
- PES Align now defaults to Yes for Video streams when creating new Manzanita muxer profiles. 
- Fix for a muxer error that was not being handled correctly when using Broadcasting 
- Fixes to better handle the muxer stream buffer full condition 
- If Manzanita is not enabled in the key, then it won’t be shown in the Processor Profile list. 
 
Nero AAC Audio codec:  For the ADTS header, the buffer fullness parameter in the header was being set 
to 0x7CF instead of the correct value of 0x7FF. 
 
The Video Preview > Encoder option now will only be shown when the selected codec can use that option. 
 
QuickTime uncompressed file capture (when the video compressor is set to “none”) is now being handled 
by a different file I/O module.  This means that you can use the “none” codec to capture an 
uncompressed YUV 4:2:2 QuickTime file in real time as long as your hard drives can sustain the data 
throughput required for the uncompressed data capture.  (Previously an inefficient file I/O module was 
being used that could only capture approximately 10 - 15 minutes to a file before the buffer was filled and 
the capture aborted.) 
 
Updated On2 (Flash 8) SDK has been integrated into Stream. 
Fixed bug in On2 Encoder where changing the Mode setting would not affect the output. 
Fixed possible bug when loading old Stream 2.3 projects with Flash 8 broadcasting. 
Added feature to On2 codec to fail the encode session when all Flash Media Server connections are lost 
during a broadcast output. Previously the encode session would continue, even after all connections to 
the media server were lost. 
 
Updated MainConcept SDK to 7.1.2 with additional D10 fixes and decoder fixes. 
 
Inverse Telecine (IVTC) interface changes to clear up the output frame rate; changes to descriptions of 
source types to add output frame rates. IVTC Plugin – for 23.976 output the declared output frame rate is 
now 23.976 (was 23.98). 
 
Issues for the DRC-5650 specifically: 
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- Fixed AES audio output to correctly specify channels status bits.  (Fixes "unlocked audio" deck problem.) 
- Fixed fractional frame rate problem for AVI files, where digitizing to AVI always resulted in an integer 
frame rate. 
 
For trimming a media file during a transcode: added media seeking to DirectShow file source. 
 
MXF FileSource:  
- Enhanced audio muxer to better handle case where last track sample precedes other track(s). 
- More changes for different MXF file formats (reading) with OpenCube Reader 
- Now explicitly inserting OpenCube DV Breaker if the OC MXF Parser exposes a DV Interleaved output 
pin, in case DirectShow doesn't load it automatically. 
 
Added new Field Dominance Converter plugin. 
 
Fix for Project Level Commands do not trigger when Watch Folder set as input type. 
 
When the input type is for a transcode, don't show the Pause state on the Start/Pause button.  (The 
Pause state does not exist for transcoding, and clicking it was causing the transcode to abort.) 
 
Fixed a problem with YUV 10-bit conversion which could occur when scaling a 10-bit YUV image. 
 
New system Tags added: 
%DECK.FRAMERATE% 
%DECK.TIMECODE.TYPE% 
%PROF.SDATE_% 
%PROF.SDATE.LOCALE% 
%PROF.SDATE.LOCALE_% 
%PROF.STIME.LOCALE% 
%PROF.STIME.LOCALE_% 
 
The number of VU meters in the VU Meter dialog now automatically tracks the number of channels in the 
selected codec profile. Previously 10 meters were always shown. 
 
Fixed a problem with concatenate output when using video-only codec profiles. 
 
Fix for a bug in the SCC encoder wherein the caption timecode would drift away from the acutal timecode 
from the video.  The Bug was caused by an imprecision in the calculation of the timecode from the frames 
when dealing with 29.97 fps frame rates. 
 
24-bit audio sources will now get down sampled to 16-bit when using the Nero Digital codec (Digital 
Rapids AVC). 
 
Update Hypersonic database - Fixes an occasional DB corruption issue. (The Hypersonic database is 
installed and started as a service automatically and is used by forensic watermarking and Transcode 
Manager functions of Stream.) 
 
Sorenson ACE bug fixes: 
Fixed ACE dialog video bitrate mode typo. 
Fixed: Sorenson ACE codec crashes encoder in 2-pass mode when Stream is set to queued mode.   
 
Added support for Global Streams TMB Encoder.  Note that the proprietary TMB codec will only be useful 
to Global Streams customers.  Please contact Digital Rapids support if you own a Global Streams system 
and would like to use the TMB Encoder in Stream. 
 
When the Vista OS is detected during install warnings are shown that advise the user about required 
Vista settings. 
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Known Limitations 
 

Vista Issues 
 
Disable the Vista power saving mode. When Vista enters “power saving mode” (hibernation), the DRC 
Stream hardware is disabled, and when you return to the normal mode and attempt to use the DRC 
Stream hardware again, it cannot be re-enabled without rebooting the system. 
 
Turn off the Vista UAC (user account control) before installing the Stream software (including drivers for 
the DRC Stream hardware).  Keep the UAC off when using the Stream software.  
 
After encoding an archive file, when you click on the Play button next to the Archive button to open the file, 
if the file would normally be played back in Windows Media Player the player will open, but the file will not 
be loaded.  This same player behavior can be seen outside of Stream in Windows Explorer by right-
clicking on a media file and selecting “Open with” and selecting the Windows Media Player: namely the 
player will open, but the file will not be loaded. 
 
The Stream Scheduler does not work on Vista. The current work around is to add tasks to the Windows 
Vista Scheduled Tasks manually. Please contact Digital Rapids Support if you need help setting this up. 
 
The ASF Processor does not work in Vista. This is the processor used in the group codec to create ASF 
files using the Microsoft VC-1 video elementary stream codec. As a work-around, you can use the 
Microsoft Wnidows Media codec to create wmv files that contain VC-1 until this issue is resolved. 
 

General Issues 
 
-  Digital Rapids does not support 64-bit Windows OS on any of the currently shipping boards. 
 
-  Stream Enterprise: When using remote control, you can initialize a Deck Capture, but you will not see 
the deck status until the deck is capturing (i.e., until encoding starts you will not see timecode, and the 
deck status will be “disconnected”).  You cannot create deck capture logs remotely. 
 
- You cannot capture analog video along with embedded SDI audio.  (Issue only applies to DRC-1400 to 
DRC-2600 boards.) 
 
-  You cannot use 2-pass encoding with Clip Lists. 
 
-  The "Fix Aspect Ratio" feature does not work for some Codec Profiles. 
 
-  DVD chapter marks may be one or two frames off from the clip in-point. 
 
-  Stream is unable to transcode from YUV image sequence files. 
 
-  When capturing timecode using the DRC-5550 or DRC-5650 board, you can only capture timecode 
from RS422 when using deck control. 
 
-  When using the DRC-5500\5650 board (the HD board), if you are making a DVD Output with 
concatenate and you are using format conversion, then the audio video sync will drift.  (If you are not 
using format conversion the audio and video will remain in sync.) 
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- Sorenson ACE:  At resolutions 640x480 and 720x480 you can use frame rate setting -1 (original frame 
rate) but not -2 (half the original frame rate). 
 
-  When using rollover mode (for archive files) and incrementing number is added automatically, but tags 
are only generated for the initial file (e.g., if %D_% is used, only the date of the initial file will be used for 
all files). 
 
-  When using rollover mode the clip that was just closed will be missing the last couple of seconds of 
audio and there may be a slight video freeze at the beginning of the next clip (a couple of seconds).  The 
audio continues normally in the new clip.  When the video starts moving again in the new clip, the video 
and audio are in sync.  
 
-  When using the roll over mode for both a Windows Media codec and a SAMI codec, the SAMI file will 
be a little out of sync with each successive roll over clip.  This is a known issue for roll over mode. 
 
-  When using rollover mode with Real Helix, the clips must be at least 60 seconds long. 
 
- Stream software cannot decode AAC audio only files. 
 
- When using Nero AAC HE v2 configurations, the encode will fail.  Use AAC HE v1 only. 
 
- If you have a DRC-1400 to 2600 board, and you enable the VBI before you have a video source input 
connected, you will see a green mask over the VBI while monitoring.  Once you connect a video source 
input it will take a few seconds for the green mask to go away. 
 
- When using the Inverse Telecine plugin, if you need to encode to an AVI file, do not set the Source Type 
to Unknown.  Set it to Film or Video.  When set to Unknown the video and audio loose sync.  Note that 
this does not happen when encoding to other codecs, just when encoding to AVI. 
 
- Digital Rapids AVC – Nero Digital encoding limitations: 

- For Mobile AVC ALL profiles default to 15fps no matter what frame rate is set in the profile. 
- For Memory Stick AVC ALL profile default to 30fps no matter what frame rate is set in the profile. 
- Nero Digital Video Decoder decodes 1920x1080 files to 1920x1088, and decoded 160x120 files 
to 160x128.  The following frame sizes are decoded correctly: 1280x720, 720x480, 640x480, and 
320x240. 
- When transcoding a stereo file source to mono AAC(LC or HE) Audio, the resulting file has 2 
channels of Audio. That is, you cannot create a mono file. 

 
- For MPEG-4 File muxing, if you use MP3 audio, only Stereo audio is supported. Mono audio is not 
supported. Playback will work in the QuickTime player, but not in the VLC Player. Other players results 
may vary with regards to MP3 playback. 
 
- When adding Chapters to an MPEG4 File, a Chapter will be automatically added at time 00:00:00:00. 
For some players this Chapter must have a name (it cannot be an untitled chapter). 
 
- There is a bug in the DR AVC for Flash 9 codec when Plugins are used. Plugins that are applied to the 
AVC/H.264 codec within the DR AVC for Flash 9 codec are deleted when the video or audio codec is 
modified. This will be corrected in a future release. 
 
- When you save a Group Codec profile with an associated plugin and then you save that codec profile, 
when you add the saved Group Codec profile to another project the plugin will be added to the project. 
 
- System tags do not work in the MPEG-4 Muxer. This will be corrected in a future release. 
 
- Live Streaming using RTP/RTSP or RTMP with AAC audio will fail after approximately 180 hours (7.5 
days). 
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